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Section 1: Network Deployment Guide 

1.0	
  Introduction	
  

	
  
VLTrader	
  allows	
  companies	
  to	
  take	
  control	
  of	
  and	
  speed	
  up	
  network	
  deployments	
  by	
  removing	
  all	
  
configuration	
  and	
  setup	
  obstacles	
  for	
  trading	
  partners	
  that	
  need	
  LexiCom	
  connect	
  to	
  VLTrader.	
  	
  To	
  
facilitate	
  VLTrader	
  network	
  rollouts,	
  VLTrader	
  administrators	
  can	
  provide	
  deployment	
  URLs	
  to	
  	
  	
  	
  	
  	
  
LexiCom	
  users.	
  	
  	
  
	
  
A	
  deployment	
  URL	
  points	
  to	
  a	
  zip	
  file	
  at	
  a	
  web	
  location	
  (possibly	
  VLTrader	
  itself)	
  and	
  can	
  contain	
  a	
  host	
  
file	
  which	
  points	
  back	
  to	
  VLTrader,	
  a	
  local	
  listener	
  file	
  which	
  is	
  preconfigured	
  with	
  LexiCom	
  listening	
  
ports,	
  a	
  user	
  certificate,	
  CA	
  certificates,	
  configuration	
  files,	
  and	
  any	
  additional	
  files	
  pertaining	
  to	
  the	
  
trading	
  relationship	
  between	
  VLTrader	
  and	
  this	
  LexiCom.	
  	
  	
  
	
  
The	
  zip	
  file	
  normally	
  would	
  be	
  created	
  using	
  a	
  dedicated	
  copy	
  of	
  CLEO	
  LexiCom,	
  using	
  the	
  File>Export	
  
feature.	
  	
  When	
  registering,	
  LexiCom	
  users	
  (trading	
  partners	
  or	
  clients)	
  will	
  be	
  prompted	
  to	
  enter	
  a	
  
specified	
  deployment	
  URL	
  to	
  download	
  the	
  configuration.	
  	
  The	
  URL	
  can	
  be	
  entered	
  during	
  initial	
  product	
  
registration;	
  or	
  later,	
  using	
  File>Import	
  or	
  via	
  command-­‐line	
  with	
  the	
  -­‐i	
  option.	
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2.0	
  Key	
  Features	
  

	
  
With	
  the	
  VLTrader	
  network	
  deployment	
  functionality	
  you	
  can:	
  
	
  

Key	
  Feature	
   Description	
   Advantage	
  

Pre-­‐configure	
  and	
  
Deploy	
  

Pre-­‐configure	
  and	
  deploy	
  LexiCom	
  listening	
  
ports,	
  user	
  certificates,	
  Self	
  signed	
  or	
  
Intermediate	
  certificates,	
  configuration	
  files,	
  
and	
  any	
  additional	
  files	
  pertaining	
  to	
  the	
  
trading	
  relationship	
  between	
  VLTrader	
  and	
  this	
  
LexiCom.	
  	
  

Reduce	
  new	
  trading	
  partner	
  setups.	
  

Create	
  Special	
  
Instructions	
  

Create	
  special	
  trading	
  partner	
  instructions	
  
displayed	
  before	
  and/or	
  after	
  the	
  automatic	
  
LexiCom	
  configuration.	
  

Customize	
  a	
  rollout	
  to	
  fit	
  your	
  needs.	
  

Create	
  Custom	
  
Splash	
  Screen	
  

Create	
  a	
  custom	
  splash	
  screen	
  displayed	
  at	
  
LexiCom	
  run-­‐time.	
  

Reduce	
  confusion	
  by	
  presenting	
  a	
  
unified	
  application.	
  

	
  

3.0	
  Configure	
  a	
  Network	
  Deployment	
  (VLTrader	
  Administrator)	
  	
  
	
  
The	
  VLTrader	
  administrator	
  must	
  use	
  a	
  dedicated	
  LexiCom	
  installation	
  to	
  actually	
  construct	
  CLEO	
  

LexiCom	
  configurations	
  for	
  trading	
  partner	
  who	
  will	
  be	
  using	
  LexiCom.	
  	
  If	
  there	
  are	
  unique	
  security	
  
features	
  per	
  LexiCom	
  user	
  (passwords,	
  certificates,	
  etc.),	
  a	
  trading	
  partner	
  specific	
  zip	
  file	
  can	
  be	
  created	
  
with	
  the	
  unique	
  configuration,	
  or	
  a	
  standard	
  configuration	
  can	
  be	
  deployed	
  that	
  can	
  be	
  imported	
  by	
  all	
  

LexiCom	
  users.	
  In	
  the	
  former	
  case,	
  this	
  requires	
  a	
  separate	
  zip	
  file	
  and	
  deployment	
  URL	
  for	
  each	
  
LexiCom	
  user.	
  In	
  the	
  latter	
  case,	
  the	
  trading	
  partner	
  specific	
  configuration	
  will	
  have	
  to	
  be	
  entered	
  by	
  the	
  
LexiCom	
  user	
  after	
  they	
  have	
  imported	
  the	
  zip	
  file.	
  To	
  provide	
  all	
  the	
  information	
  as	
  part	
  of	
  the	
  

deployment,	
  it	
  is	
  recommended	
  that	
  instructions	
  for	
  entering	
  this	
  information	
  be	
  provided	
  within	
  the	
  
postreadme.txt	
  file	
  with	
  the	
  specific	
  values	
  being	
  provided	
  via	
  the	
  e-­‐mail	
  (or	
  other	
  communication)	
  
used	
  to	
  provide	
  the	
  deployment	
  URL	
  to	
  the	
  trading	
  partner.	
  Alternatively,	
  the	
  instructions	
  could	
  be	
  

provided	
  in	
  this	
  same	
  e-­‐mail.	
  

3.1	
  Export	
  User	
  Configuration	
  Files	
  

	
  
The	
  network	
  deployment	
  process	
  begins	
  by	
  the	
  VLTrader	
  administrator	
  constructing	
  a	
  CLEO	
  LexiCom	
  
configuration	
  for	
  trading	
  partners.	
  	
  Once	
  the	
  configuration	
  is	
  constructed,	
  the	
  VLTrader	
  administrator	
  
will	
  export	
  the	
  configuration	
  out	
  of	
  LexiCom	
  as	
  a	
  zip	
  file	
  to	
  a	
  location	
  accessible	
  to	
  trading	
  partners	
  via	
  a	
  
URL.	
  	
  To	
  export	
  LexiCom	
  user	
  files	
  to	
  a	
  zip	
  file,	
  select	
  File>Export	
  in	
  the	
  menu	
  bar.	
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Select	
  any	
  combination	
  of	
  host	
  files,	
  configuration	
  files,	
  user	
  certificates,	
  and	
  CA	
  certificate	
  files.	
  	
  A	
  
private	
  key	
  password	
  must	
  be	
  provided	
  with	
  each	
  selected	
  user	
  certificate	
  -­‐	
  the	
  exported	
  user	
  
certificates	
  and	
  associated	
  private	
  keys	
  are	
  exported	
  as	
  PKCS#12	
  files.	
  	
  Any	
  additional	
  files	
  may	
  also	
  	
  	
  	
  	
  	
  
be	
  selected.	
  
	
  
*Note,	
  a	
  pre	
  and/or	
  post	
  import	
  message	
  can	
  be	
  included.	
  	
  See	
  section	
  3.2	
  before	
  exporting.	
  
*Note,	
  a	
  custom	
  splash	
  screen	
  can	
  be	
  in	
  included.	
  	
  See	
  section	
  3.3	
  before	
  exporting.
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After	
  selecting	
  the	
  appropriate	
  files,	
  click	
  Export.	
  
	
  

	
  
	
  
Select	
  the	
  location	
  to	
  save	
  the	
  LexiCom-­‐exported	
  zip	
  file	
  and	
  click	
  Save.	
  	
  
	
  

3.2	
  Create	
  Trading	
  Partner	
  Instructions	
  (optional)	
  

	
  
In	
  File>Export,	
  if	
  specially	
  named	
  "prereadme.txt"	
  and/or	
  "postreadme.txt"	
  files	
  are	
  included	
  as	
  
additional	
  files	
  in	
  the	
  export,	
  then	
  when	
  the	
  exported	
  file	
  is	
  imported	
  during	
  Registration	
  or	
  when	
  using	
  
File>Import,	
  the	
  contents	
  of	
  these	
  files	
  are	
  displayed	
  as	
  pre-­‐import	
  and	
  post-­‐import	
  instructions	
  before	
  
and	
  after	
  the	
  file	
  import.	
  	
  If	
  using	
  the	
  command-­‐line	
  -­‐i	
  option	
  rather	
  than	
  File>Import,	
  the	
  instructions	
  
are	
  printed	
  to	
  the	
  console.	
  	
  The	
  following	
  is	
  an	
  example	
  display	
  of	
  a	
  “prereadme.txt”	
  message	
  being	
  
utilized	
  to	
  provide	
  additional	
  steps	
  to	
  test	
  connections	
  after	
  a	
  deployment.	
  	
  	
  
	
  

	
  
	
  
(Note:	
  	
  The	
  export	
  locations	
  of	
  the	
  “prereadme.txt”	
  and	
  “postreadme.txt”	
  files	
  are	
  not	
  important	
  as	
  
these	
  files	
  will	
  not	
  be	
  copied	
  to	
  the	
  file	
  system	
  during	
  import.	
  	
  Rather,	
  they	
  are	
  just	
  for	
  display	
  	
  	
  	
  	
  	
  	
  	
  
during	
  import.)	
  	
  	
  
	
  

3.3	
  Create	
  a	
  Custom	
  Splash	
  Screen	
  (optional)	
  

	
  
A	
  custom	
  splash	
  screen	
  can	
  be	
  placed	
  in	
  the	
  conf/images	
  directory	
  and	
  specified	
  as	
  a	
  part	
  of	
  the	
  
export/import	
  process.	
  	
  The	
  filename	
  must	
  start	
  with	
  "splash."	
  and	
  supported	
  formats	
  include	
  JPEG,	
  GIF,	
  
and	
  PNG.	
  	
  The	
  image	
  can	
  be	
  no	
  larger	
  than	
  525X340	
  pixels	
  and	
  no	
  smaller	
  than	
  250X100	
  pixels.	
  	
  	
  An	
  
example	
  of	
  a	
  custom	
  splash	
  screen	
  used	
  for	
  soft	
  branding	
  is	
  shown	
  below.	
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3.4	
  Make	
  User	
  Files	
  Available	
  for	
  Download	
  

	
  
The	
  VLTrader	
  administrator	
  can	
  make	
  the	
  exported	
  zip	
  file	
  (user	
  configuration	
  files)	
  available	
  for	
  
download	
  by	
  1)	
  creating	
  an	
  HTTP	
  server	
  mailbox	
  in	
  VLTrader,	
  2)	
  copying	
  the	
  exported	
  zip	
  file	
  into	
  the	
  
mailbox	
  directory,	
  and	
  3)	
  providing	
  the	
  mailbox	
  username	
  and	
  password	
  and	
  the	
  associated	
  URL	
  to	
  
LexiCom	
  users.	
  	
  (Note:	
  	
  Refer	
  to	
  the	
  Local	
  Listener	
  section	
  of	
  the	
  VersaLex	
  Users	
  Guide	
  for	
  see	
  how	
  to	
  
setup	
  the	
  HTTP	
  listener.	
  	
  Refer	
  to	
  the	
  Local	
  HTTP	
  Users	
  Configuration	
  section	
  for	
  setting	
  up	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
HTTP	
  mailboxes.)	
  
	
  
After	
  the	
  HTTP	
  mailbox	
  is	
  created,	
  copy	
  the	
  exported	
  zip	
  file	
  into	
  the	
  HTTP	
  mailbox	
  payload	
  directory	
  as	
  
follows.	
  	
  In	
  the	
  example	
  below,	
  the	
  mailbox	
  name	
  (username)	
  is	
  “download”.	
  
	
  

	
  
	
  
	
  
The	
  URL	
  includes	
  1)	
  the	
  IP	
  and	
  Port	
  for	
  the	
  HTTP	
  (or	
  HTTPs)	
  listener,	
  2)	
  the	
  HTTP	
  server	
  path	
  (by	
  default,	
  
“server”)	
  and	
  3)	
  the	
  name	
  of	
  the	
  exported	
  zip	
  file.	
  	
  The	
  following	
  is	
  an	
  example.	
  
	
   	
  

Definition:	
  	
  http://[server	
  address]:[listening	
  port]/[server	
  path]/[zip	
  file	
  name]	
  
Example:	
  	
  http://125.165.211.9:5080/server/LexiCom.zip	
  

	
  

	
  

4.0	
  Configure	
  LexiCom	
  Using	
  the	
  Deployment	
  URL	
  (LexiCom	
  Trading	
  Partner)	
  

	
  

HTTP	
  Mailbox	
  Name	
  

Location	
  of	
  exported	
  zip	
  file	
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NOTE:	
  	
  We	
  recommend	
  that	
  the	
  VLTrader	
  administrator	
  tests	
  the	
  URL	
  deployment	
  process	
  described	
  
below	
  and	
  the	
  LexiCom	
  connectivity	
  back	
  to	
  VLTrader,	
  before	
  making	
  it	
  available	
  to	
  LexiCom	
  users.	
  
	
  
After	
  installing	
  LexiCom,	
  LexiCom	
  users	
  complete	
  the	
  following	
  steps	
  to	
  import	
  user	
  files	
  using	
  the	
  
deployment	
  URL.	
  
	
  

1. Start	
  LexiCom	
  (for	
  the	
  first	
  time).	
  	
  As	
  a	
  part	
  of	
  the	
  first-­‐time	
  startup	
  process,	
  LexiCom	
  prompts	
  to	
  
register	
  LexiCom.	
  

	
  
2. Enter	
  the	
  serial	
  number	
  and	
  the	
  Deployment	
  URL.	
  	
  The	
  serial	
  number	
  and	
  Deployment	
  URL	
  

should	
  be	
  provided	
  by	
  the	
  VLTrader	
  administrator.	
  	
  The	
  following	
  is	
  a	
  sample	
  deployment	
  URL.	
  
	
  

3. Click	
  Check	
  Registration.	
  
	
  

	
  
	
  

4. Click	
  OK.	
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LexiCom	
  will	
  then	
  prompt	
  to	
  download	
  and	
  import	
  the	
  LexiCom	
  user	
  configuration	
  files.	
  	
  The	
  
deployment	
  URL	
  that	
  was	
  previously	
  entered	
  will	
  be	
  displayed.	
  
	
  

5. Click	
  Download.	
  

	
  
	
  

6. Enter	
  the	
  Username	
  and	
  Password	
  provided	
  by	
  the	
  VLTrader	
  administrator.	
  	
  	
  

	
  
	
  

7. The	
  LexiCom	
  Import	
  option	
  will	
  be	
  displayed	
  with	
  all	
  items	
  selected.	
  	
  Click	
  Import	
  to	
  continue	
  to	
  
complete	
  the	
  LexiCom	
  deployment.	
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Once	
  the	
  import	
  is	
  complete,	
  the	
  imported	
  items	
  (hosts,	
  certs,	
  etc.)	
  are	
  immediately	
  available	
  for	
  use.	
  
	
  
A	
  Note	
  about	
  User	
  Certificates	
  
The	
  File>Export	
  utility	
  includes	
  the	
  ability	
  to	
  export	
  user	
  certificates	
  and	
  private	
  keys	
  as	
  PKCS#12	
  files	
  in	
  
the	
  created	
  zip	
  file.	
  	
  Likewise,	
  the	
  File>Import	
  utility	
  looks	
  for	
  PKCS#12	
  files	
  in	
  the	
  zip	
  file	
  and	
  if	
  present,	
  
allows	
  for	
  import.	
  	
  A	
  password	
  must	
  be	
  provided	
  for	
  each	
  user	
  certificate	
  being	
  exported	
  and	
  imported.	
  	
  
If	
  using	
  the	
  command-­‐line	
  -­‐i	
  option	
  rather	
  than	
  File>Import,	
  the	
  command-­‐line	
  will	
  prompt	
  for	
  each	
  
PKCS#12	
  file	
  password.	
  
	
  
VersaLex-­‐exported	
  zip	
  files	
  can	
  also	
  be	
  imported	
  using	
  the	
  VersaLex	
  command	
  line	
  -­‐i	
  option	
  (refer	
  to	
  
Execute	
  from	
  Command	
  Line	
  in	
  the	
  VersaLex	
  User	
  Guide).	
  	
  	
  
	
  



Section	
  2:	
  Certificate	
  Management	
  Guide	
  

11	
  

	
  

Section 2:  Certificate Management Guide 

1.0	
  Introduction	
  
	
  
VLTrader	
  provides	
  certificate	
  management	
  capability	
  that	
  allows	
  users	
  to	
  easily	
  manage	
  these	
  and	
  other	
  
certificate	
  headaches.	
  	
  	
  
	
  
There	
  are	
  many	
  inherent	
  difficulties	
  managing	
  certificates	
  for	
  large	
  trading	
  partner	
  communities.	
  	
  Three	
  
of	
  the	
  major	
  difficulties	
  include:	
  
	
  

• Quick,	
  Efficiently	
  on-­‐ramping	
  new	
  trading	
  partners	
  with	
  certificates.	
  	
  For	
  example,	
  	
  
o Creating	
  or	
  obtaining	
  certificates	
  for	
  each	
  trading	
  partner	
  
o Obtaining	
  public	
  keys	
  from	
  each	
  trading	
  partner	
  
o Providing	
  your	
  public	
  key	
  certificate	
  to	
  each	
  trading	
  partner	
  

• Effectively	
  updating	
  certificates	
  when	
  they	
  expire	
  or	
  are	
  revoked	
  
• Keeping	
  track	
  of	
  how	
  certificates	
  are	
  being	
  used	
  within	
  the	
  community	
  for	
  each	
  trading	
  partner	
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2.0	
  Key	
  Features	
  

	
  
Key	
  Feature	
   Description	
   Advantage	
  

Include	
  Certificates	
  
as	
  a	
  Partner	
  of	
  a	
  
VLTrader	
  Network	
  
Deployment	
  

Include	
  user	
  certificates	
  and	
  CA	
  
certificates	
  when	
  deploying	
  preconfigured	
  
LexiCom	
  client	
  software	
  to	
  trading	
  
partners.	
  	
  

Keep	
  all	
  configuration	
  files	
  together	
  
in	
  one	
  package,	
  decreasing	
  setup	
  
time.	
  

Exchange	
  
Certificates	
  with	
  
Trading	
  Partners	
  

Automatically	
  exchange	
  certificates	
  as	
  a	
  
part	
  of	
  the	
  enhanced	
  AS2	
  protocol	
  
(Certificate	
  Exchange	
  Messaging):	
  	
  CEM	
  
works	
  with	
  all	
  Cleo-­‐to-­‐Cleo	
  relationships	
  
as	
  well	
  as	
  all	
  other	
  CEM-­‐capable	
  products.	
  

Save	
  time	
  by	
  instantly	
  updating	
  
certificate	
  without	
  interaction	
  
required	
  from	
  your	
  CEM	
  capable	
  
trading	
  partner.	
  

Email	
  Certificates	
  
from	
  within	
  
VLTrader	
  

For	
  non-­‐CEM	
  capable	
  relationships,	
  users	
  
can	
  easily	
  email	
  public	
  key	
  certificates	
  to	
  
trading	
  partner	
  from	
  within	
  VLTrader.	
  

Combine	
  exporting	
  and	
  emailing	
  
certificates	
  into	
  one	
  easy	
  to	
  use	
  
step.	
  

Schedule	
  
Certificates	
  for	
  
Future	
  Use	
  

Select	
  local	
  and/or	
  partner	
  certificates	
  to	
  
be	
  activated	
  for	
  use	
  at	
  a	
  scheduled	
  time.	
  

Allows	
  overlapping	
  certificate	
  
resulting	
  in	
  more	
  efficient	
  
certificate	
  exchange.	
  

View	
  Certificate	
  
Usage	
  

Display	
  user	
  and	
  trusted	
  CA	
  certificates,	
  
the	
  certificate	
  expiration	
  dates,	
  and	
  the	
  
specific	
  active	
  host	
  usages.	
  

Easily	
  keep	
  track	
  of	
  all	
  your	
  trading	
  
partner	
  certificates.	
  

Certificate	
  
Expiration	
  Email	
  
Notification	
  

Configure	
  VLTrader	
  to	
  notify	
  you	
  when	
  
user	
  and	
  CA	
  certificates	
  are	
  about	
  to	
  
expire.	
  	
  The	
  warning	
  length	
  of	
  time	
  is	
  
configurable.	
  

Never	
  be	
  surprised	
  by	
  expiring	
  
certificates.	
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3.0	
  Implement	
  a	
  Certificate	
  Management	
  Plan	
  
	
  
The	
  following	
  are	
  special	
  considerations	
  for	
  you	
  to	
  consider	
  when	
  developing	
  a	
  plan	
  to	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
manage	
  certificates.	
  
	
  

• Am	
  I	
  deploying	
  LexiCom	
  to	
  my	
  trading	
  community?	
  
• What	
  protocols	
  am	
  I	
  using	
  to	
  connect	
  with	
  my	
  trading	
  community?	
  
• If	
  a	
  segment	
  of	
  my	
  trading	
  community	
  is	
  not	
  using	
  Cleo,	
  are	
  these	
  non-­‐LexiCom	
  trading	
  

partners	
  CEM-­‐compliant?	
  
• How	
  much	
  warning	
  do	
  I	
  need	
  when	
  certificates	
  (user	
  and	
  CA)	
  are	
  about	
  to	
  expire?	
  
• How	
  will	
  I	
  communicate	
  my	
  certificate	
  processes	
  to	
  my	
  trading	
  community?	
  

	
  
Cleo	
  works	
  with,	
  and	
  has	
  put	
  together	
  best-­‐practices	
  for	
  different	
  trading	
  communities,	
  based	
  
on	
  our	
  experience	
  and	
  feedback	
  from	
  our	
  clients.	
  
	
  
Community	
  Type	
   Recommendations	
   Advantage	
  

I	
  will	
  have	
  a	
  mixed	
  community,	
  
able	
  to	
  deploy	
  LexiCom	
  clients	
  
to	
  some	
  trading	
  partner	
  and	
  no	
  
control	
  over	
  other	
  trading	
  
partners.	
  

A	
  hybrid	
  community	
  is	
  the	
  most	
  common	
  
and	
  requires	
  a	
  hybrid	
  approach	
  to	
  
certificate	
  management	
  as	
  follows.	
  
1. Pre-­‐configure	
  LexiCom	
  for	
  trading	
  

partners,	
  including	
  generating	
  trading	
  
partner	
  user	
  certificates.	
  

2. Exchange	
  certificates	
  prior	
  to	
  
deployment.	
  

3. Use	
  AS2	
  to	
  take	
  advantage	
  of	
  
Certificate	
  Exchange	
  Messaging	
  (CEM).	
  

4. When	
  necessary,	
  email	
  public	
  key	
  
certificates	
  to	
  trading	
  partners	
  from	
  
within	
  VLTrader.	
  
	
  

VLTrader	
  can	
  handle	
  
both	
  types	
  of	
  certificate	
  
exchange	
  to	
  give	
  you	
  
maximum	
  flexibility	
  

I	
  have	
  the	
  ability	
  to	
  deploy	
  a	
  
closed	
  network	
  (e.g.,	
  trading	
  
partners	
  will	
  use	
  LexiCom);	
  
where	
  my	
  goal	
  is	
  to	
  streamline	
  
processes	
  and	
  reduce	
  
dependence	
  on	
  trading	
  partners	
  
for	
  successfully	
  managing	
  my	
  
B2B	
  communications.	
  	
  

1. Preconfigure	
  LexiCom	
  for	
  trading	
  
partners,	
  including	
  generating	
  trading	
  
partner	
  user	
  certificates.	
  

2. Exchange	
  certificates	
  prior	
  to	
  
deployment.	
  

3. Use	
  AS2	
  to	
  take	
  advantage	
  of	
  
Certificate	
  Exchange	
  Messaging	
  (CEM).	
  

4. Configure	
  VLTrader	
  to	
  notify	
  
stakeholders	
  15	
  days	
  before	
  
certificates	
  expire.	
  

Complete	
  control	
  over	
  
installation	
  and	
  
certificate	
  exchange.	
  

I	
  have	
  no	
  control	
  over	
  the	
  client	
  
software	
  or	
  protocols	
  that	
  my	
  
trading	
  partners	
  will	
  use,	
  and	
  
very	
  few	
  will	
  be	
  using	
  LexiCom.	
  

1. Email	
  public	
  key	
  certificates	
  to	
  trading	
  
partners	
  from	
  within	
  VLTrader.	
  

2. Configure	
  VLTrader	
  to	
  notify	
  
stakeholders	
  15	
  days	
  before	
  
certificates	
  expire.	
  

Overlapping	
  certificates	
  
allow	
  for	
  a	
  more	
  
efficient	
  certificate	
  
exchange.	
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3.1	
  Deploy	
  Certificates	
  to	
  Trading	
  Partners	
  

	
  
Note:	
  	
  Refer	
  to	
  the	
  Network	
  Deployment	
  guide	
  for	
  a	
  complete	
  description	
  of	
  how	
  to	
  configure	
  
LexiCom	
  for	
  network	
  deployment.	
  	
  The	
  following	
  describes	
  the	
  process	
  to	
  deploy	
  certificates.	
  	
  	
  
	
  
Note:	
  Refer	
  to	
  the	
  Certificate	
  Manager	
  section	
  of	
  the	
  VLTrader	
  User	
  Guide	
  for	
  the	
  certificate-­‐
specific	
  steps.	
  
	
  
Step	
   Description	
  

1) Create	
  a	
  trading	
  partner	
  
user	
  certificate	
  

	
  

	
  
	
  

2) Import	
  the	
  trading	
  
partner	
  user	
  certificate	
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3) Import	
  your	
  public	
  key	
  
certificate	
  

	
  

	
  
	
  

4) Configure	
  VLTrader	
  to	
  
warn	
  stakeholders	
  via	
  
email	
  that	
  certificates	
  
are	
  about	
  to	
  expire.	
  

	
  

	
  
	
  

5) Create	
  additional	
  
documents	
  to	
  be	
  
included	
  as	
  part	
  of	
  the	
  
deployment	
  process	
  .	
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3.2	
  Certificate	
  Exchange	
  Messaging	
  (CEM)	
  

	
  
Certificates	
  may	
  be	
  exchanged	
  with	
  your	
  trading	
  partners	
  through	
  several	
  methods.	
  	
  The	
  most	
  
popular	
  method	
  is	
  via	
  email,	
  however	
  an	
  additional	
  method	
  for	
  exchanging	
  certificates	
  securely	
  
over	
  the	
  internet,	
  referred	
  to	
  as	
  EDIINT	
  Certificate	
  Exchange	
  Messaging,	
  is	
  beginning	
  to	
  be	
  used	
  
as	
  an	
  alternative	
  to	
  email.	
  	
  EDIINT	
  Certificate	
  Exchange	
  Messaging	
  (also	
  referred	
  to	
  as	
  CEM)	
  was	
  
developed	
  through	
  an	
  initiative	
  piloted	
  by	
  the	
  Drummond	
  Group	
  to	
  automate	
  the	
  secure	
  
exchange	
  of	
  public-­‐key	
  certificates	
  between	
  trading	
  partners	
  over	
  the	
  internet.	
  	
  Since	
  the	
  
structure	
  of	
  a	
  Certificate	
  Exchange	
  Message	
  is	
  of	
  a	
  specific	
  format	
  (currently	
  only	
  supported	
  in	
  
AS2),	
  Certificate	
  Exchange	
  Messages	
  should	
  only	
  be	
  sent	
  to	
  trading	
  partners	
  capable	
  of	
  receiving	
  
and	
  processing	
  CEM	
  messages.	
  	
  The	
  Cleo	
  VersaLex	
  products	
  are	
  CEM	
  capable	
  and	
  will	
  be	
  able	
  to	
  
successfully	
  process	
  properly-­‐formed	
  CEM	
  messages.	
  	
  CEM	
  messages	
  should	
  only	
  be	
  used	
  to	
  
update	
  existing	
  certificates	
  in	
  an	
  established	
  trading	
  partner	
  relationship.	
  	
  The	
  initial	
  exchange	
  
of	
  certificates	
  for	
  new	
  trading	
  partner	
  relationships	
  should	
  be	
  done	
  out-­‐of-­‐band	
  (e.g.,	
  through	
  
the	
  Email	
  Profile	
  Utility).	
  
	
  
Certificate	
  Exchange	
  functionality	
  for	
  CEM	
  is	
  managed	
  by	
  the	
  Certificate	
  Exchange	
  Dialog	
  which	
  
displays	
  all	
  active	
  and	
  if	
  applicable,	
  pending	
  or	
  rejected	
  certificates	
  for	
  each	
  trading	
  partner	
  
relationship.	
  	
  Features	
  of	
  the	
  dialog	
  include:	
  	
  	
  
	
  

Feature	
   	
  

	
  
Sorting	
  and	
  filtering	
  of	
  records	
  by	
  protocol	
  and	
  current	
  status	
  

	
  
X	
  

	
  
Additional	
  filtering	
  of	
  records	
  by	
  certificate	
  selection	
  

	
  
X	
  

	
  
Simultaneous	
  selection	
  of	
  multiple	
  records	
  that	
  are	
  currently	
  filtered	
  by	
  the	
  
same	
  protocol	
  and	
  status	
  
	
  

	
  
X	
  

	
  
Command	
  options	
  available	
  for	
  any/all	
  selected	
  records	
  based	
  on	
  the	
  
current	
  filter	
  settings	
  	
  
	
  

	
  
X	
  

	
  
The	
  ability	
  to	
  send	
  new	
  certificates	
  to	
  your	
  trading	
  partner	
  through	
  EDIINT	
  
Certificate	
  Exchange	
  Messaging	
  (CEM)	
  -­‐	
  if	
  your	
  trading	
  partner	
  is	
  CEM-­‐
capable;	
  or	
  through	
  email	
  if	
  your	
  trading	
  partner	
  is	
  not	
  CEM-­‐capable	
  or	
  if	
  
you	
  are	
  setting	
  up	
  the	
  initial	
  trading	
  partner	
  relationship	
  and	
  have	
  never	
  
previously	
  exchanged	
  certificates	
  with	
  a	
  trading	
  partner	
  
	
  

	
  
X	
  

	
  
Certificates	
  for	
  individually	
  selected	
  records	
  may	
  be	
  viewed	
  by	
  either	
  right-­‐
clicking	
  on	
  that	
  record	
  and	
  choosing	
  the	
  ‘Display’	
  option	
  or	
  by	
  double-­‐
clicking	
  on	
  a	
  specific	
  record.	
  	
  (Viewing	
  of	
  certificates	
  for	
  multiply	
  selected	
  
records	
  is	
  not	
  supported.)	
  

	
  
X	
  

Note:	
  	
  Refer	
  to	
  the	
  Certificate	
  Manager	
  of	
  the	
  VLTrader	
  User	
  Guide	
  for	
  a	
  complete	
  description	
  
of	
  how	
  to	
  leverage	
  Certificate	
  Exchange	
  Messaging	
  from	
  with	
  VLTrader.	
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3.3	
  Schedule	
  Certificates	
  for	
  Future	
  Use	
  

	
  
VLTrader	
  provides	
  the	
  ability	
  to	
  select	
  local	
  and/or	
  partner	
  certificates	
  on	
  a	
  per	
  trading	
  partner	
  
basis.	
  Certificates	
  can	
  be	
  activated	
  for	
  use	
  at	
  a	
  scheduled	
  time	
  in	
  the	
  future	
  or	
  immediately.	
  	
  	
  
Additionally,	
  trading	
  partners	
  using	
  AS2	
  protocols	
  will	
  automatically	
  be	
  able	
  to	
  take	
  advantage	
  
of	
  the	
  "first-­‐usage"	
  features	
  for	
  scheduled	
  local	
  encryption	
  certificates	
  and	
  scheduled	
  partner	
  
signing	
  certificates.	
  
	
  
Note:	
  	
  Since	
  EDIINT	
  Certificate	
  Exchange	
  Messaging	
  already	
  provides	
  a	
  mechanism	
  for	
  sending,	
  
receiving,	
  installation	
  and	
  "first-­‐usage"	
  of	
  certificates,	
  scheduling	
  of	
  certificates	
  for	
  future	
  use	
  is	
  
only	
  available	
  for	
  non	
  AS2-­‐CEM	
  protocols.	
  
	
  
To	
  schedule	
  new	
  certificates	
  for	
  future	
  use	
  for	
  one	
  or	
  more	
  trading	
  partners:	
  	
  	
  
	
  

	
  
	
  

1. Select	
  the	
  desired	
  non-­‐AS2-­‐CEM	
  trading	
  partner(s)	
  on	
  the	
  My	
  Certs	
  or	
  the	
  Trading	
  
Partner	
  Certs	
  panel	
  
	
  

2. Select	
  the	
  'Schedule	
  Certificates	
  For	
  Future	
  Use'	
  command	
  option	
  
	
  

3. Click	
  the	
  Proceed	
  button	
  
	
  
The	
  following	
  dialog	
  will	
  appear	
  allowing	
  for	
  the	
  selection	
  and	
  scheduling	
  of	
  new	
  applicable	
  
certificates	
  for	
  this	
  trading	
  relationship:	
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1. Select	
  the	
  new	
  certificate(s)	
  by	
  clicking	
  the	
  Browse	
  button	
  or	
  by	
  typing	
  the	
  alias	
  of	
  the	
  
new	
  certificate(s)	
  directly	
  in	
  the	
  specified	
  Alias	
  fields.	
  
	
  

2. Input	
  the	
  private	
  key	
  password	
  to	
  the	
  Password	
  field.	
  	
  	
  
	
  

3. Select	
  the	
  Use	
  Signing	
  Certificate	
  option	
  to	
  choose	
  the	
  same	
  certificate	
  for	
  Signing	
  and	
  
Encryption	
  or	
  deselect	
  this	
  option	
  to	
  use	
  different	
  certificates	
  for	
  Signing	
  and	
  
Encryption.	
  

	
  
4. The	
  SSL	
  Client	
  Certificate	
  Alias	
  and	
  Password	
  fields	
  will	
  only	
  be	
  enabled	
  if	
  an	
  SSL	
  Client	
  

certificate	
  had	
  been	
  previously	
  selected	
  for	
  the	
  trading	
  relationship.	
  To	
  override	
  
selection	
  of	
  these	
  fields,	
  the	
  Schedule	
  SSL	
  Client	
  Certificate	
  checkbox	
  may	
  be	
  selected	
  or	
  
deselected	
  as	
  desired.	
  

	
  
5. The	
  SSL	
  Server	
  Certificate	
  Alias	
  and	
  Password	
  fields	
  will	
  only	
  be	
  enabled	
  if	
  the	
  associated	
  

HTTP/s	
  or	
  FTP/s	
  port	
  has	
  been	
  enabled	
  in	
  the	
  Local	
  Listener.	
  To	
  override	
  selection	
  of	
  
these	
  fields,	
  the	
  Schedule	
  SSL	
  Server	
  Certificate	
  checkbox	
  may	
  be	
  selected	
  or	
  deselected	
  
as	
  desired.	
  

	
  
6. Select	
  the	
  desired	
  Activation	
  Date	
  and	
  Time	
  from	
  pull-­‐down	
  lists	
  or	
  specify	
  your	
  own	
  

date	
  (in	
  the	
  form:	
  'yyyy/mm/dd')	
  and	
  time	
  (in	
  the	
  form:	
  hh:mm	
  or	
  hh:mm:ss).	
  	
  
	
  

7. Once	
  all	
  the	
  desired	
  new	
  certificates	
  for	
  the	
  trading	
  relationship	
  have	
  been	
  selected	
  and	
  
desired	
  activation	
  date	
  and	
  time	
  has	
  been	
  chosen,	
  click	
  the	
  Schedule	
  button	
  to	
  schedule	
  
the	
  selected	
  certificates	
  for	
  future	
  use.	
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8. The	
  following	
  confirmation	
  dialog	
  will	
  be	
  displayed	
  allowing	
  for	
  final	
  verification	
  of	
  the	
  
certificates	
  before	
  the	
  certificates	
  are	
  scheduled	
  for	
  activation.	
  
	
  

	
  
	
  
If	
  you	
  click	
  [Yes],	
  all	
  selected	
  certificates	
  will	
  be	
  scheduled	
  for	
  installation	
  and	
  activation	
  
for	
  the	
  specified	
  trading	
  partner(s).	
  	
  Clicking	
  the	
  [No]	
  button	
  brings	
  you	
  back	
  to	
  the	
  
previous	
  'Schedule	
  Local	
  Certificates'	
  panel	
  allowing	
  you	
  the	
  option	
  of	
  choosing	
  either	
  
new	
  certificates	
  and/or	
  a	
  new	
  activation	
  date/time.	
  	
  
	
  

9. The	
  status	
  of	
  the	
  selected	
  record(s)	
  will	
  be	
  set	
  to	
  Scheduled	
  and	
  the	
  option	
  to	
  email	
  the	
  
scheduled	
  certificates	
  to	
  your	
  trading	
  partner(s)	
  will	
  be	
  given.	
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10. The	
  new	
  certificates	
  will	
  be	
  displayed	
  in	
  the	
  panel	
  with	
  the	
  current	
  certificates	
  and	
  will	
  
not	
  be	
  editable	
  until	
  after	
  the	
  scheduled	
  certificate	
  activation	
  date	
  and	
  time	
  has	
  elapsed	
  
or	
  your	
  trading	
  partner	
  begins	
  encrypting	
  with	
  the	
  new	
  encryption	
  certificate.	
  
 

 
At	
  that	
  time,	
  all	
  previously	
  scheduled	
  certificates	
  will	
  be	
  activated	
  and	
  an	
  email	
  
notification	
  will	
  be	
  sent	
  to	
  the	
  email	
  address	
  specified	
  in	
  the	
  Admin	
  Email	
  Address	
  field	
  
on	
  the	
  Other	
  tab	
  in	
  Configure	
  System	
  Options	
  panel.	
  
	
  

11. If	
  a	
  new	
  SSL	
  Server	
  certificate	
  was	
  scheduled,	
  the	
  new	
  certificate	
  will	
  be	
  displayed	
  in	
  
either	
  the	
  Local	
  Listener’s	
  HTTP	
  or	
  FTP	
  panel	
  (depending	
  on	
  the	
  protocol)	
  with	
  the	
  
current	
  certificate.	
  	
  The	
  Certificate	
  Alias	
  field	
  will	
  be	
  read-­‐only	
  until	
  all	
  partners	
  using	
  the	
  
same	
  SSL	
  protocol	
  have	
  scheduled	
  the	
  new	
  certificate	
  and	
  that	
  scheduled	
  date	
  has	
  
elapsed.	
  	
  Once	
  this	
  has	
  occurred,	
  the	
  new	
  SSL	
  Server	
  certificate	
  will	
  automatically	
  be	
  
installed	
  (normally	
  within	
  five-­‐minutes).	
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12. Since	
  only	
  one	
  HTTP	
  or	
  FTP	
  SSL	
  Server	
  certificate	
  may	
  be	
  active	
  at	
  any	
  time,	
  the	
  new	
  SSL	
  
Server	
  certificate	
  will	
  be	
  the	
  only	
  certificate	
  that	
  may	
  be	
  scheduled	
  for	
  all	
  subsequent	
  
schedule	
  requests.	
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3.4	
  View	
  Certificate	
  Usage	
  

Certificate	
  usage	
  can	
  be	
  displayed	
  to	
  provide	
  a	
  single,	
  easy	
  to	
  use	
  interface	
  for	
  all	
  you	
  active	
  certificates.	
  	
  
View	
  User	
  and	
  CA	
  certificate	
  usage	
  as	
  follows.	
  
	
  

1. Select	
  View>Usage...	
  in	
  the	
  menu	
  bar.	
  
	
  

	
  

2. Each	
  user	
  and	
  trusted	
  CA	
  certificate	
  is	
  listed	
  by	
  either	
  alias	
  (user	
  certificate)	
  or	
  filename	
  (CA	
  
certificate).	
  	
  Supplemental	
  information	
  includes	
  the	
  certificate	
  expiration	
  date	
  and	
  specific	
  
active	
   	
  host	
  usage.	
  	
  A	
  certificate	
  is	
  repeated	
  in	
  the	
  list	
  if	
  it	
  has	
  multiple	
  uses.	
  	
  Double-­‐click	
  a	
  
certificate	
  to	
  display	
  a	
  detailed	
  description.	
  

	
  

	
  
	
  

3. The	
  Save	
  As	
  options	
  can	
  be	
  used	
  to	
  save	
  the	
  report	
  as	
  a	
  HTML	
  file	
  for	
  offline	
  viewing	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
or	
  distribution.	
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4.0	
  The	
  Certificate	
  Manager	
  
	
  
VLTrader’s	
  Certificate	
  Manager	
  provides	
  robust	
  management	
  of	
  digital	
  certificates	
  and	
  private	
  keys.	
  	
  The	
  
following	
  is	
  a	
  list	
  of	
  features	
  that	
  it	
  supports.	
  	
  Refer	
  to	
  the	
  Certificate	
  Manager	
  section	
  of	
  the	
  VLTrader	
  
User	
  Guide	
  for	
  detailed	
  instructions	
  on	
  how	
  to	
  use	
  each	
  of	
  these	
  features.	
  

	
  
Feature	
   	
  

	
  
Generate	
  PEM-­‐formatted	
  Certificate	
  Signing	
  Requests	
  
	
  

	
  
X	
  

	
  
Generate	
  Trusted	
  CA	
  Certificates	
  from	
  OpenPGP	
  or	
  SSH	
  FTP	
  Keys	
  
	
  

	
  
X	
  

	
  
Import	
  User	
  Certificates,	
  CA	
  Certificates	
  and	
  Private	
  Keys	
  
	
  

	
  
X	
  

	
  
Export	
  Certificates	
  and	
  Private	
  Keys	
  
	
  

	
  
X	
  

	
  
Export	
  OpenPGP	
  or	
  SSH	
  FTP	
  Keys	
  
	
  

	
  
X	
  

	
  
Replace	
  	
  Trusted	
  CA	
  Certificates	
  
	
  

	
  
X	
  

	
  
Move	
  Pending	
  Certificates	
  to	
  Trusted	
  CA	
  Certificates	
  (and	
  Vice	
  Versa)	
  
	
  

	
  
X	
  

	
  
Remove	
  Certificates	
  
	
  

	
  
X	
  

	
  
View	
  Certificate	
  Usage	
  
	
  

	
  
X	
  

	
  
Exchange	
  Certificates	
  with	
  Trading	
  Partners	
  
	
  

	
  
X	
  

	
  
Schedule	
  Certificates	
  for	
  Future	
  Use	
  
	
  

	
  
X	
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5.0	
  Cryptographic	
  Services	
  
	
  
5.1	
  Cryptographic	
  Services	
  	
  
	
  
The	
  Cleo	
  products	
  support	
  three	
  different	
  cryptosystems:	
  	
  S/MIME,	
  XML,	
  and	
  OpenPGP.	
  	
  S/MIME	
  is	
  
supported	
  through	
  AS2	
  and	
  AS3	
  (see	
  AS2	
  mailbox	
  AS2	
  tab	
  as	
  an	
  example).	
  	
  XML	
  is	
  supported	
  through	
  
ebXML	
  (see	
  ebXML	
  mailbox	
  ebXML	
  tab)	
  and	
  mailbox-­‐level	
  encryption	
  (see	
  Configure	
  the	
  Mailbox	
  
Encryption	
  Tab).	
  	
  OpenPGP	
  is	
  supported	
  through	
  FTP	
  and	
  SSH	
  FTP	
  (see	
  Configure	
  the	
  Mailbox	
  	
  	
  	
  	
  	
  	
  
OpenPGP	
  Tab).	
  
	
  
For	
  complete	
  details	
  on	
  these	
  types	
  of	
  cryptosystems,	
  and	
  their	
  uses	
  in	
  signing	
  and	
  encryption,	
  refer	
  to	
  
the	
  VersaLex	
  user’s	
  guide	
  under	
  Cryptographic	
  Services	
  Overview.	
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Section 3:  Deploy Custom Community Web Portals 

1.0	
  Introduction	
  
	
  
Successful	
  partner	
  enablement	
  goes	
  beyond	
  the	
  initial	
  contact.	
  VLTrader	
  provides	
  an	
  easy-­‐to-­‐use	
  and	
  
customizable	
  web-­‐portal	
  to	
  allow	
  low-­‐tech	
  or	
  low-­‐volume	
  users	
  with	
  a	
  manual	
  transfer	
  option;	
  or,	
  
alternatively,	
  to	
  provide	
  a	
  back-­‐up	
  method	
  for	
  client-­‐enabled,	
  automated	
  partners.	
  With	
  only	
  an	
  
Internet	
  connection	
  and	
  a	
  web	
  browser,	
  the	
  web	
  portal	
  user	
  can	
  easily	
  upload	
  and	
  download	
  files	
  to	
  and	
  
from	
  the	
  VLTrader	
  server,	
  view	
  file	
  transfer	
  history,	
  and	
  access	
  any	
  custom	
  web	
  pages	
  that	
  have	
  been	
  
configured	
  by	
  the	
  VLTrader	
  administrator.	
  
	
  
Web	
  Portals	
  can	
  be	
  customized	
  for	
  look	
  and	
  feel	
  as	
  well	
  as	
  for	
  the	
  actual	
  portal	
  content.	
  	
  The	
  special	
  
value	
  of	
  the	
  web	
  portal	
  functionality	
  is	
  1)	
  it	
  is	
  extremely	
  easy	
  to	
  configure	
  and	
  implement,	
  and	
  2)	
  it	
  
allows	
  companies	
  to	
  pursue	
  a	
  comprehensive	
  B2B	
  communications	
  strategy	
  including	
  automated	
  and	
  ad	
  
hoc	
  options	
  for	
  trading	
  partners,	
  yet	
  consolidated	
  into	
  a	
  single	
  solution.	
  	
  The	
  Web	
  Portal	
  is	
  intended	
  to	
  
be	
  a	
  complement	
  and	
  alternative	
  to	
  the	
  core	
  automated	
  B2B	
  file	
  transfer	
  processes.	
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2.0	
  Key	
  Features	
  

	
  
The	
  web	
  portal	
  allows:	
  
	
  
Key	
  Feature	
   Description	
   Advantage	
  

Image	
  Customization	
   VLTrader	
  administrators	
  can	
  customize	
  the	
  
logo,	
  banner,	
  and	
  navigation	
  bar	
  images.	
  	
  

Customers	
  can	
  easily	
  recognize	
  
your	
  web	
  portal.	
  

Content	
  
Customization	
  

VLTrader	
  administrators	
  can	
  create	
  web	
  
pages	
  with	
  custom	
  content,	
  link	
  to	
  external	
  
pages,	
  provide	
  access	
  to	
  related	
  
documentation,	
  etc.	
  

Easily	
  link	
  customers	
  back	
  to	
  your	
  
website,	
  or	
  include	
  important	
  
information.	
  

Embedding	
  “Base”	
  
Pages	
  into	
  External	
  
Pages	
  

VLTrader	
  administrators	
  can	
  embed	
  base	
  
pages	
  (upload/download	
  and	
  file	
  transfer	
  
history)	
  into	
  other,	
  external	
  pages	
  or	
  
portals.	
  

Allow	
  access	
  to	
  the	
  web	
  portal	
  
directly	
  from	
  your	
  website.	
  

Upload	
  and	
  
Download	
  Files	
  

Web	
  portal	
  users	
  can	
  manually	
  upload	
  and	
  
download	
  files.	
  

Easy	
  and	
  cost	
  effective	
  solution	
  
for	
  your	
  customers.	
  

View	
  File	
  Transfer	
  
History	
  

Web	
  portal	
  users	
  can	
  view	
  their	
  file	
  
transfer	
  history	
  for	
  both	
  ad	
  hoc	
  file	
  
transfers	
  and	
  automated	
  transfers.	
  

Easy	
  data	
  tracking	
  for	
  your	
  
customers.	
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3.0	
  Configure	
  a	
  Web	
  Portal	
  (VLTrader	
  Admin)	
  	
  
	
  
The	
  web	
  portal	
  feature	
  allows	
  your	
  trading	
  partners	
  to	
  perform	
  ad	
  hoc	
  payload	
  transfers	
  and	
  to	
  view	
  
transfer	
  reports,	
  all	
  through	
  some	
  simple	
  web	
  pages.	
  	
  This	
  can	
  be	
  utilized	
  as	
  a	
  secondary	
  means	
  to	
  an	
  
automated	
  file	
  transfer,	
  or	
  as	
  an	
  option	
  for	
  low	
  volume	
  users.	
  The	
  Web	
  Portal	
  pages	
  can	
  be	
  customized	
  
to	
  add	
  additional	
  company	
  specific	
  information	
  or	
  pages.	
  	
  	
  	
  
	
  

3.1	
  Customize	
  the	
  Portal	
  Interface	
  

	
  
Refer	
  to	
  the	
  following	
  image	
  to	
  clarify	
  web	
  portal	
  page	
  customization	
  and	
  configuration,	
  discussed	
  in	
  
this	
  section.	
  

	
  

On	
  the	
  VLPortal	
  tab	
  (on	
  the	
  Web	
  Browser	
  node	
  of	
  the	
  Local	
  Listener):	
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1. The	
  VLPortal	
  Resource	
  Path	
  defaults	
  to	
  the	
  component	
  name	
  ("/VLPortal").	
  	
  Your	
  trading	
  
partners	
  must	
  include	
  this	
  resource	
  path	
  in	
  the	
  URL	
  when	
  accessing	
  VersaLex	
  through	
  a	
  web	
  
browser.	
  	
  It	
  can	
  be	
  changed	
  at	
  any	
  time,	
  but	
  must	
  start	
  with	
  a	
  forward	
  slash	
  (/)	
  character.	
  	
  For	
  
example,	
  http://216.239.51.99:5080/VLPortal.	
  
	
  

2. The	
  Portal	
  Title	
  is	
  defaulted	
  to	
  the	
  company	
  name	
  in	
  the	
  VLTrader	
  registration	
  and	
  can	
  be	
  edited	
  
at	
  the	
  VLPortal	
  configuration	
  screen..	
  	
  The	
  Portal	
  Title	
  is	
  displayed	
  on	
  the	
  web	
  browser	
  title	
  bar	
  
for	
  each	
  portal	
  page.	
  	
  

	
  
3. Use	
  Images...	
  to	
  customize	
  the	
  graphic	
  images	
  within	
  the	
  framework	
  of	
  the	
  web	
  portal.	
  	
  	
  

	
  

In	
  the	
  VLPortal	
  Images	
  dialog:	
  
	
  

	
  

	
  

• The	
  Logo	
  defaults	
  to	
  "img/defaultlogo.jpg".	
  	
  This	
  image	
  is	
  displayed	
  in	
  the	
  upper	
  left-­‐
hand	
  corner	
  of	
  each	
  web	
  portal	
  page.	
  	
  It	
  can	
  be	
  changed	
  to	
  any	
  customized	
  image	
  (e.g.,	
  
your	
  company	
  logo).	
  
	
  

• The	
  Banner	
  defaults	
  to	
  "img/banner.jpg".	
  	
  This	
  image	
  is	
  displayed	
  along	
  the	
  top	
  of	
  each	
  
web	
  portal	
  page.	
  	
  It	
  can	
  be	
  changed	
  to	
  any	
  customized	
  image	
  (e.g.,	
  your	
  company	
  
banner).	
  	
  A	
  banner	
  size	
  of	
  approximately	
  2000w	
  X	
  84h	
  pixels	
  is	
  recommended.	
  
	
  

• The	
  Menu	
  defaults	
  to	
  "img/navpic.jpg".	
  	
  This	
  image	
  is	
  displayed	
  in	
  the	
  navigation	
  bar,	
  
along	
  the	
  left	
  border	
  of	
  each	
  web	
  portal	
  page.	
  	
  It	
  can	
  be	
  changed	
  to	
  any	
  customized	
  
image.	
  
	
  

• Use	
  [Import...]	
  to	
  import	
  new	
  graphic	
  images	
  that	
  can	
  subsequently	
  be	
  selected	
  through	
  
the	
  Logo,	
  Banner,	
  and	
  Menu	
  fields.	
  	
  All	
  imported	
  files	
  are	
  stored	
  in	
  
'webserver\VLPortal\img\'	
  under	
  the	
  VLTrader	
  home	
  directory.	
  

	
  

4. Configure	
  the	
  Navigation	
  Menu	
  table	
  to	
  customize	
  the	
  web	
  portal	
  interface	
  to	
  your	
  trading	
  
partners.	
  	
  Each	
  row	
  in	
  the	
  table	
  represents	
  one	
  web	
  page.	
  	
  Use	
  the	
  right-­‐click	
  menu	
  options	
  to	
  
manipulate	
  each	
  row.	
  	
  Only	
  one	
  row	
  may	
  be	
  selected	
  at	
  a	
  time.	
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The	
  default	
  configuration	
  provides	
  three	
  pages:	
  
	
  

• VLPortal	
  default	
  home	
  page	
  (VLTrader	
  Web	
  Portal)	
  
	
  

• Ad	
  hoc	
  file	
  transfer	
  page	
  (Manual	
  File	
  Transfer)	
  
	
  

• Transfer	
  reporting	
  page	
  (File	
  Transfer	
  History)	
  
	
  

Use	
  right-­‐click	
  menus	
  on	
  each	
  table	
  entry	
  to	
  determine	
  which	
  options	
  are	
  available	
  for	
  each	
  
page.	
  	
  The	
  following	
  rules	
  apply.	
  
	
  

• VLTrader	
  Web	
  Portal:	
  	
  is	
  included	
  by	
  default;	
  may	
  not	
  be	
  excluded;	
  title	
  and	
  contents	
  
may	
  be	
  modified;	
  may	
  not	
  be	
  removed;	
  must	
  be	
  first	
  within	
  the	
  navigation	
  menu;	
  may	
  
not	
  be	
  moved	
  within	
  the	
  navigation	
  menu.	
  
	
  

• Manual	
  File	
  Transfer	
  and	
  File	
  Transfer	
  History:	
  	
  is	
  included	
  by	
  default;	
  may	
  be	
  excluded;	
  
only	
  the	
  title	
  may	
  be	
  modified;	
  contents	
  may	
  not	
  be	
  modified;	
  may	
  not	
  be	
  removed;	
  may	
  
be	
  moved	
  within	
  navigation	
  menu.	
  
	
  

• Any	
  other	
  newly-­‐created	
  page:	
  	
  is	
  included	
  by	
  default;	
  may	
  be	
  excluded;	
  title	
  and	
  
contents	
  may	
  be	
  modified;	
  may	
  be	
  removed;	
  may	
  be	
  moved	
  within	
  the	
  navigation	
  menu.	
  
	
  

3.2	
  Add/Edit	
  Pages	
  (via	
  editor)	
  

	
  

To	
  edit	
  a	
  page,	
  select	
  "Edit..."	
  from	
  the	
  desired	
  row's	
  right-­‐click	
  menu.	
  	
  If	
  the	
  row	
  corresponds	
  to	
  
Manual	
  File	
  Transfer	
  or	
  File	
  Transfer	
  History,	
  the	
  following	
  is	
  displayed.	
  	
  Recall	
  that	
  only	
  page	
  
title	
  may	
  be	
  changed	
  for	
  these	
  two	
  web	
  pages.	
  
	
  

	
  

	
  

If	
  any	
  other	
  web	
  page	
  is	
  chosen,	
  the	
  following	
  is	
  displayed.	
  	
  In	
  the	
  Edit	
  dialog,	
  select	
  Custom	
  to	
  
modify	
  your	
  custom-­‐built	
  web	
  page.	
  	
  These	
  are	
  pages	
  that	
  you	
  have	
  created	
  within	
  VLTrader.	
  	
  
Select	
  Link	
  to	
  insert	
  a	
  link	
  directly	
  to	
  any	
  web	
  pages	
  that	
  have	
  been	
  built	
  outside	
  of	
  the	
  
VLTrader.	
  	
  The	
  following	
  is	
  displayed	
  for	
  the	
  Custom	
  option.	
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Each	
  row	
  in	
  the	
  table	
  represents	
  specific	
  content	
  for	
  the	
  web	
  page.	
  	
  Use	
  the	
  right-­‐click	
  menu	
  
options	
  to	
  manipulate	
  each	
  row.	
  	
  A	
  range	
  of	
  rows	
  may	
  selected,	
  only	
  within	
  the	
  VLTrader	
  native	
  
GUI.	
  	
  When	
  manipulating	
  a	
  range	
  of	
  rows,	
  the	
  SHIFT	
  key	
  must	
  be	
  held	
  down	
  while	
  selecting	
  the	
  
right-­‐click	
  menu	
  option.	
  	
  Note	
  that	
  the	
  last	
  row	
  of	
  the	
  table	
  will	
  always	
  be	
  empty.	
  
	
  

1. Section	
  Text	
  is	
  represented	
  as	
  heading	
  text	
  on	
  the	
  web	
  page	
  (HTML	
  <H2>	
  tag).	
  	
  	
  
	
  

2. Line	
  Break,	
  if	
  checked,	
  is	
  represented	
  as	
  a	
  blank	
  line	
  on	
  the	
  web	
  page	
  (HTML	
  <BR>	
  tag).	
  	
  	
  
	
  

3. The	
  Detail/Link	
  Text	
  is	
  represented	
  in	
  one	
  of	
  two	
  ways	
  on	
  the	
  web	
  page:	
  
• If	
  the	
  Link	
  field	
  is	
  empty,	
  then	
  Detail/Link	
  Text	
  is	
  represented	
  as	
  detailed	
  text.	
  
• If	
  the	
  Link	
  field	
  contains	
  a	
  hyperlink,	
  then	
  Detail/Link	
  Text	
  is	
  represented	
  an	
  

underlined	
  link	
  reference.	
  
	
  

4. The	
  Link	
  field	
  represents	
  the	
  actual	
  hyperlink.	
  	
  To	
  insert	
  or	
  edit	
  a	
  link,	
  select	
  "Edit	
  Link..."	
  
from	
  the	
  desired	
  row's	
  right-­‐click	
  menu.	
  	
  The	
  following	
  will	
  be	
  displayed.	
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In	
  the	
  Edit	
  Link	
  dialog:	
  

	
  

	
  

	
  

• Select	
  None	
  to	
  clear	
  the	
  link.	
  
	
  

• Select	
  URL	
  to	
  enter	
  a	
  valid	
  URL	
  (e.g.,	
  a	
  link	
  to	
  your	
  company's	
  web	
  site).	
  
	
  

• Select	
  Document	
  to	
  select	
  a	
  document	
  (e.g.,	
  a	
  PDF	
  of	
  documentation	
  pertinent	
  to	
  your	
  
trading	
  partner).	
  

	
  	
  
• Use	
  [Import...]	
  to	
  import	
  new	
  documents	
  that	
  can	
  subsequently	
  be	
  selected	
  through	
  the	
  

Document	
  field.	
  	
  All	
  imported	
  files	
  are	
  stored	
  in	
  'webserver\VLPortal\doc\'	
  under	
  the	
  
VLTrader	
  home	
  directory.	
  

	
  

3.3	
  Add/Edit	
  Pages	
  (via	
  URL)	
  

	
  

In	
  the	
  Edit	
  dialog,	
  the	
  following	
  is	
  displayed	
  for	
  the	
  Link	
  option.	
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• Select	
  URL	
  to	
  enter	
  a	
  valid	
  URL	
  (e.g.,	
  a	
  link	
  to	
  your	
  company's	
  web	
  site).	
  	
  	
  
	
  

• Select	
  HTML	
  to	
  select	
  any	
  valid	
  HTML	
  page.	
  
	
  

• Use	
  [Import...]	
  to	
  import	
  new	
  HTML	
  files	
  that	
  can	
  subsequently	
  be	
  selected	
  through	
  the	
  
HTML	
  field.	
  	
  All	
  imported	
  files	
  are	
  stored	
  in	
  'webserver\VLPortal\html\'	
  under	
  the	
  
VLTrader	
  home	
  directory.	
  

	
  

Please	
  note	
  the	
  following	
  with	
  regard	
  to	
  Link	
  pages.	
  	
  	
  
	
  

1. If	
  the	
  HTML	
  option	
  is	
  used,	
  any	
  images	
  that	
  are	
  referenced	
  within	
  the	
  HTML	
  file	
  should	
  
be	
  placed	
  in	
  'webserver\VLPortal\img\'	
  under	
  the	
  VLTrader	
  home	
  directory.	
  	
  This	
  can	
  be	
  
accomplished	
  through	
  the	
  [Import...]	
  button	
  under	
  the	
  VLPortal	
  Images	
  dialog	
  	
  	
  	
  
discussed	
  above.	
  
	
  

2. It	
  is	
  the	
  user's	
  responsibility	
  to	
  ensure	
  that	
  any	
  content	
  and	
  style	
  sheets	
  are	
  compatible	
  
with	
  the	
  web	
  portal	
  framework.	
  

	
  

3.4	
  Configure	
  a	
  Trading	
  Partner	
  

	
  

After	
  activating	
  the	
  HTTP	
  Local	
  Users	
  host	
  from	
  the	
  preconfigured	
  tab,	
  you	
  can	
  configure	
  the	
  root	
  and	
  
individual	
  partner	
  mailboxes.	
  

	
  

	
  
	
  

1. The	
  HTTP	
  User	
  Name	
  is	
  simply	
  the	
  mailbox	
  alias.	
  	
  Enter	
  a	
  unique	
  alias	
  to	
  be	
  used	
  by	
  your	
  
trading	
  partner	
  to	
  log	
  into	
  your	
  HTTP	
  server.	
  
	
  

2. The	
  User	
  Home	
  Directory	
  defaults	
  to	
  a	
  username	
  subdirectory	
  under	
  the	
  default	
  root	
  
directory.	
  	
  To	
  override	
  this	
  path	
  for	
  this	
  user	
  only,	
  uncheck	
  Use	
  Default	
  Root\Username	
  
and	
  either	
  enter	
  the	
  path	
  or	
  use	
  the	
  [...]	
  button	
  to	
  select	
  a	
  new	
  home	
  directory.	
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3. The	
  Pipe	
  Incoming	
  Payload	
  allows	
  for	
  this	
  trading	
  partner	
  to	
  send	
  to	
  your	
  HTTP	
  server	
  
and	
  redirect,	
  or	
  pipe,	
  the	
  incoming	
  payload	
  out	
  through	
  a	
  different	
  protocol.	
  	
  Should	
  the	
  
transfer	
  out	
  to	
  the	
  pipe	
  mailbox	
  fail,	
  then	
  the	
  transfer	
  into	
  the	
  local	
  mailbox	
  will	
  	
  	
  	
  	
  	
  	
  	
  	
  
also	
  fail.	
  

	
  
4. The	
  Associate	
  to	
  Primary	
  Mailbox	
  indicates	
  an	
  alternate	
  host\mailbox	
  location	
  for	
  

payload	
  transfers	
  with	
  this	
  trading	
  partner.	
  	
  Please	
  note	
  that,	
  even	
  if	
  the	
  primary	
  
mailbox	
  is	
  specified,	
  all	
  transfers	
  are	
  still	
  classified	
  under	
  the	
  local	
  HTTP	
  user	
  
host\mailbox	
  (and	
  not	
  the	
  primary	
  host\mailbox).	
  

	
  
5. The	
  HTTP	
  server	
  supports	
  either	
  password-­‐based	
  WWW	
  authentication	
  or	
  public	
  key-­‐

based	
  SSL	
  client	
  authentication.	
  	
  
	
  

Note:	
  If	
  using	
  VLProxy	
  to	
  reverse	
  proxy	
  into	
  VLTrader,	
  VLProxy	
  only	
  supports	
  WWW	
  
authentication	
  for	
  identifying	
  HTTP	
  clients	
  and	
  does	
  not	
  support	
  SSL	
  client	
  authentication.	
  
	
  

a. WWW	
  Authentication	
  using	
  a	
  Password:	
  Enter	
  the	
  user’s	
  Password	
  and	
  confirm	
  
that	
  you	
  entered	
  it	
  correctly	
  by	
  retyping	
  it	
  in	
  the	
  Confirm	
  Password.	
  Passwords	
  
are	
  encoded	
  on	
  the	
  screen	
  and	
  in	
  the	
  user	
  configuration	
  file.	
  
	
  

b. SSL	
  Client	
  Authentication	
  using	
  a	
  CA	
  Certificate:	
  Specify	
  the	
  name	
  of	
  the	
  file	
  
containing	
  the	
  Client’s	
  Authentication	
  Certificate	
  (the	
  remote	
  client	
  certificate	
  
to	
  be	
  used	
  for	
  authentication)	
  by	
  clicking	
  the	
  [Browse...]	
  button.	
  	
  Find	
  the	
  
certificate	
  that	
  matches	
  the	
  one	
  you	
  received	
  from	
  your	
  trading	
  partner	
  and	
  

click	
   .	
  	
  	
  
	
  

Note:	
  Authenticate	
  Client	
  in	
  the	
  Local	
  Host:	
  HTTP	
  Tab	
  must	
  be	
  enabled.	
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3.5	
  Provide	
  Access	
  to	
  the	
  Web	
  Portal	
  

	
  

Before	
  your	
  trading	
  partners	
  can	
  access	
  the	
  web	
  portal,	
  you	
  must	
  first	
  establish	
  a	
  mailbox	
  for	
  each	
  partner	
  
under	
  the	
  local	
  HTTP	
  users	
  (refer	
  to	
  Mailbox	
  HTTP	
  Tab),	
  and,	
  next,	
  provide	
  the	
  partners	
  with	
  the	
  proper	
  
URL	
  (e.g.,	
  http(s)://VLTraderComputerIP:http(s)Port/VLPortalResourcePath).	
  	
  Once	
  these	
  steps	
  are	
  
followed,	
  your	
  trading	
  partners	
  should	
  access	
  the	
  web	
  portal	
  by	
  entering	
  the	
  specified	
  URL	
  into	
  their	
  
browser.	
  	
  They	
  will	
  be	
  prompted	
  for	
  a	
  login.	
  	
  	
  

	
  

	
  

	
  

The	
  User	
  name	
  and	
  Password	
  are	
  those	
  that	
  were	
  established	
  within	
  the	
  trading	
  partner's	
  mailbox	
  
under	
  the	
  local	
  HTTP	
  user.	
  	
  After	
  logging	
  in,	
  the	
  partner	
  will	
  be	
  presented	
  with	
  the	
  VLPortal	
  home	
  page.	
  	
  
The	
  navigation	
  within	
  the	
  web	
  portal	
  is	
  determined	
  by	
  the	
  setup	
  you	
  established	
  under	
  the	
  VLPortal	
  tab.	
  	
  
For	
  a	
  description	
  of	
  the	
  VLPortal	
  base	
  pages,	
  as	
  the	
  web-­‐portal	
  user	
  would	
  see	
  them,	
  refer	
  to	
  VLPortal	
  
Base	
  Web	
  Pages.	
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3.6	
  Embed	
  Base	
  Pages	
  into	
  “External”	
  Pages	
  (outside	
  the	
  web	
  portal)	
  

	
  

It	
  is	
  possible	
  to	
  link	
  directly	
  to	
  a	
  web	
  portal	
  base	
  page	
  (refer	
  to	
  VLPortal	
  Base	
  Pages)	
  from	
  your	
  own	
  web	
  
pages.	
  	
  In	
  order	
  to	
  access	
  a	
  base	
  page	
  in	
  this	
  manner,	
  it	
  is	
  first	
  necessary	
  to	
  log	
  in,	
  as	
  discussed	
  in	
  
Providing	
  Access	
  to	
  the	
  Web	
  Portal.	
  	
  The	
  URL	
  you	
  provide	
  will	
  contain	
  parameters	
  to	
  direct	
  the	
  display	
  of	
  
the	
  desired	
  page(s).	
  	
  Refer	
  to	
  the	
  table	
  below.	
  

	
  

URL	
   Link	
  Results	
  (after	
  login)	
  

http(s)://VLTraderComputerIP:http(s)Port/	
  

VLPortalResourcePath?reportName=	
  

FileTransferHistory	
  

&external=true	
  

The	
  Transfer	
  Reporting	
  page	
  provided.	
  

http(s)://VLTraderComputerIP:http(s)Port/	
  

VLPortalResourcePath?reportName=	
  

ManualFileTransfer	
  

&external=true	
  

The	
  Ad	
  Hoc	
  File	
  Transfers	
  page	
  is	
  provided.	
  

http(s)://VLTraderComputerIP:http(s)Port/	
  

VLPortalResourcePath?reportName=	
  

FileTransferHistory,ManualFileTransfer	
  

&external=true	
  

The	
  Transfer	
  Reporting	
  and	
  Ad	
  Hoc	
  File	
  
Transfers	
  pages	
  are	
  provided,	
  in	
  the	
  order	
  
specified,	
  through	
  a	
  tabbed	
  pane	
  within	
  a	
  
single	
  page.	
  

	
  

Please	
  note	
  that	
  you	
  should	
  not	
  provide	
  multiple	
  links	
  to	
  the	
  base	
  pages	
  within	
  the	
  same	
  web	
  
browser	
  session.	
  	
  If	
  you	
  wish	
  to	
  display	
  multiple	
  base	
  pages,	
  you	
  should	
  request	
  all	
  pages	
  within	
  one	
  
URL,	
  using	
  a	
  comma-­‐separated	
  list	
  as	
  shown	
  in	
  the	
  table	
  above.	
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4.0	
  Using	
  the	
  Web	
  Portal	
  (Trading	
  Partner)	
  	
  

	
  
The	
  Web	
  Portal	
  user	
  can	
  perform	
  ad	
  hoc	
  file	
  transfer	
  and	
  view	
  their	
  file	
  transfer	
  history	
  as	
  follows.	
  	
  
	
  

4.1	
  Ad	
  Hoc	
  File	
  Transfers	
  

	
  
This	
  web	
  page	
  shown	
  below	
  is	
  used	
  to	
  perform	
  ad	
  hoc	
  file	
  transfers	
  to/from	
  the	
  VLTrader	
  HTTP	
  server.	
  	
  
Note	
  that	
  the	
  name	
  of	
  this	
  page	
  (in	
  example	
  below,	
  "Manual	
  File	
  Transfer")	
  is	
  configurable	
  by	
  the	
  
VLTrader	
  administrator,	
  so	
  the	
  title	
  may	
  change.	
  	
  However,	
  the	
  content	
  of	
  the	
  page	
  will	
  remain	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  
the	
  same.	
  

 

 
Note regarding general web page usage:  The standard browser forward and 

back buttons should not be used when navigating within, and between, the 

VLPortal base pages.  Instead use the left-menu pane to navigate between the 

pages.  Also, the standard browser refresh button should not be used.  Instead 

use the [Refresh] buttons provided on the web pages. 
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1. The	
  Server	
  Upload	
  Directory	
  designates	
  the	
  VLTrader	
  directory	
  to	
  which	
  files	
  can	
  be	
  uploaded.	
  	
  
If	
  multiple	
  directory	
  locations	
  have	
  been	
  set	
  up	
  by	
  the	
  VLTrader	
  administrator,	
  a	
  new	
  directory	
  
may	
  be	
  chosen	
  from	
  the	
  drop-­‐down	
  list.	
  	
  Select	
  ".."	
  to	
  move	
  up	
  a	
  directory;	
  select	
  ".\current	
  
directory\subdirectory"	
  to	
  move	
  down	
  a	
  directory.	
  	
  
	
  

2. Press	
  [Upload...]	
  to	
  select	
  a	
  local	
  file	
  that	
  you	
  wish	
  to	
  upload.	
  	
  
	
  

3. The	
  Server	
  Download	
  Directory	
  designates	
  the	
  VLTrader	
  directory	
  from	
  which	
  files	
  can	
  be	
  
downloaded.	
  	
  If	
  multiple	
  directory	
  locations	
  have	
  been	
  set	
  up	
  by	
  the	
  VLTrader	
  administrator,	
  a	
  
new	
  directory	
  may	
  be	
  chosen	
  from	
  the	
  drop-­‐down	
  list.	
  	
  Select	
  ".."	
  to	
  move	
  up	
  a	
  directory;	
  select	
  
".\current	
  directory\subdirectory"	
  to	
  move	
  down	
  a	
  directory.	
  	
  

	
  
4. The	
  table	
  shown	
  below	
  the	
  Server	
  Download	
  Directory	
  contains	
  a	
  listing	
  of	
  the	
  files	
  within	
  that	
  

directory.	
  	
  By	
  clicking	
  on	
  the	
  column	
  headers,	
  the	
  table	
  can	
  be	
  sorted	
  in	
  ascending	
  or	
  
descending	
  order,	
  based	
  on	
  the	
  selected	
  column's	
  content.	
  	
  Within	
  the	
  table,	
  multiple	
  files	
  may	
  
be	
  selected,	
  through	
  the	
  use	
  of	
  the	
  SHIFT	
  and	
  CTRL	
  keys.	
  	
  Use	
  the	
  right-­‐click	
  menu	
  options	
  to	
  
"Download..."	
  or	
  "Delete..."	
  files	
  from	
  the	
  server.	
  

	
  
5. Press	
  [All]	
  to	
  select	
  all	
  the	
  rows	
  in	
  the	
  table.	
  	
  

	
  
6. Press	
  [None]	
  to	
  deselect	
  all	
  the	
  rows	
  in	
  the	
  table.	
  

	
  
7. Press	
  [Refresh]	
  to	
  update	
  the	
  table	
  display	
  in	
  the	
  case	
  where	
  the	
  directory's	
  contents	
  may	
  have	
  

changed.	
  
	
  

8. Press	
  [Help]	
  to	
  obtain	
  an	
  HTML	
  display	
  of	
  this	
  documentation.	
  	
  The	
  information	
  will	
  be	
  displayed	
  
in	
  a	
  separate	
  browser	
  tab.	
  

	
  
9. Zip	
  single-­‐selection	
  file	
  download,	
  if	
  selected,	
  will	
  download	
  any	
  individual	
  file	
  within	
  a	
  

compressed/zip	
  archive.	
  	
  When	
  multiple	
  files	
  are	
  selected	
  for	
  download,	
  a	
  compressed/zip	
  
archive	
  is	
  automatically	
  created,	
  irrespective	
  of	
  this	
  checkbox	
  setting.	
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4.2	
  Transfer	
  Reporting	
  

 

VLTrader	
  transfer	
  logging,	
  if	
  enabled,	
  logs	
  information	
  (e.g.,	
  file	
  size,	
  transfer	
  time,	
  status,	
  etc.)	
  
regarding	
  the	
  upload	
  and	
  download	
  of	
  files.	
  	
  When	
  processing	
  multiple	
  files	
  in	
  a	
  batch,	
  it	
  logs	
  each	
  	
  	
  	
  	
  	
  	
  
file	
  individually.	
  	
  	
  
	
  
This	
  page	
  is	
  used	
  to	
  review	
  the	
  status	
  of	
  all	
  file	
  transfers	
  associated	
  with	
  your	
  HTTP	
  user	
  mailbox	
  and,	
  
optionally,	
  if	
  configured	
  by	
  your	
  VLTrader	
  administrator,	
  your	
  primary	
  mailbox.	
  	
  Note	
  that	
  the	
  name	
  of	
  
this	
  page	
  (in	
  example	
  below,	
  "File	
  Transfer	
  History")	
  is	
  configurable	
  by	
  the	
  VLTrader	
  administrator,	
  so	
  
the	
  title	
  may	
  change.	
  	
  However,	
  the	
  content	
  of	
  the	
  page	
  will	
  remain	
  the	
  same.	
  	
  Also	
  note	
  that,	
  if	
  transfer	
  
logging	
  is	
  not	
  enabled	
  within	
  VLTrader,	
  you	
  will	
  receive	
  a	
  message	
  stating	
  this,	
  rather	
  than	
  viewing	
  	
  	
  	
  	
  	
  
this	
  screen.	
  

 

 

Note regarding general web page usage:  The standard browser forward and 

back buttons should not be used when navigating within, and between, the 

VLPortal base pages.  Instead use the left-menu pane to navigate between the 

pages.  Also, the standard browser refresh button should not be used.  Instead 

use the [Refresh] buttons provided on the web pages. 
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1. The	
  Cleo	
  VLPortal	
  Transfer	
  Report	
  shows	
  the	
  status	
  all	
  file	
  uploads	
  and	
  downloads	
  associated	
  
with	
  your	
  configured	
  mailboxes.	
  	
  Initially,	
  only	
  the	
  current	
  day's	
  transfers	
  will	
  be	
  displayed.	
  	
  You	
  
may	
  change	
  the	
  period	
  range	
  by	
  clicking	
  on	
  the	
  [Filter...]	
  button	
  (see	
  discussion	
  of	
  [Filter...]	
  
below).	
  	
  By	
  clicking	
  on	
  the	
  column	
  headers,	
  the	
  table	
  can	
  be	
  sorted	
  in	
  ascending	
  or	
  descending	
  
order,	
  based	
  on	
  the	
  selected	
  column's	
  content.	
  	
  You	
  may	
  right-­‐click	
  on	
  a	
  row	
  to	
  view	
  detailed	
  
information	
  about	
  a	
  transfer.	
  	
  Only	
  one	
  row	
  may	
  be	
  selected	
  at	
  a	
  time.	
  	
  When	
  you	
  select	
  "View	
  
Information..."	
  on	
  a	
  row,	
  the	
  following	
  page	
  is	
  displayed	
  in	
  a	
  separate	
  browser	
  tab.	
  

 

 
 

2. Press	
  [Filter...]	
  to	
  customize	
  the	
  items	
  you	
  wish	
  to	
  display	
  in	
  the	
  Cleo	
  VLPortal	
  Transfer	
  Report	
  
table	
  	
  in	
  the	
  Cleo	
  VLPortal	
  Transfer	
  Report	
  Filter.	
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• The	
  From	
  and	
  To	
  fields	
  allow	
  you	
  to	
  select	
  a	
  range	
  of	
  time	
  you	
  wish	
  to	
  view.	
  	
  You	
  may	
  
either	
  use	
  the	
  pull-­‐down	
  menus	
  or	
  enter	
  specific	
  information	
  into	
  the	
  date	
  
(YYYY/MM/DD)	
  and	
  time	
  (HH:MM)	
  fields.	
  

	
  
• You	
  may	
  filter	
  based	
  on	
  specific	
  Host\Mailboxes,	
  Statuses,	
  and	
  Transfer	
  Directions.	
  
• Press	
  the	
  [All]	
  button	
  to	
  select	
  all	
  the	
  rows	
  for	
  the	
  particular	
  section	
  to	
  which	
  the	
  button	
  

applies.	
  
	
  
• Press	
  the	
  [None]	
  button	
  to	
  deselect	
  all	
  the	
  rows	
  for	
  the	
  particular	
  section	
  to	
  which	
  the	
  

button	
  applies.	
  
	
  

• Press	
  the	
  [Continue]	
  button	
  refresh	
  the	
  display	
  with	
  specified	
  filter	
  criteria.	
  
	
  

• Press	
  the	
  [Cancel]	
  button	
  to	
  cancel	
  the	
  operation	
  and	
  return	
  to	
  the	
  previous	
  display.	
  
	
  

• Press	
  [Help]	
  to	
  obtain	
  an	
  HTML	
  display	
  of	
  this	
  documentation.	
  	
  The	
  information	
  will	
  be	
  
displayed	
  in	
  a	
  separate	
  browser	
  tab.	
  

 

If EDI logging is enabled on the connected VLTrader, the user can also filter based on EDI 
criteria.  Note that the Ref # and Ack Status fields are additional EDI logging options that can 
be enabled by the VLTrader administrator.  Partial ref #s can be wild-carded by using the 
special % character at the beginning or end of the search value. 
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1. Press [Refresh] to update the table display in the case where new items are available.  The 
refresh re-reads the data based on the current filter and re-displays the data. 
 

2. Press [Generate Report...] to display the report generation filter dialog.  The filter dialogs (for 
both Transfers and EDI) were described above.  When generating a report, the dialogs appear 
slightly different.  For completeness, the dialog for transfer report generation is shown below 
as an example.   In the Cleo VLPortal Transfer Report Filter: 

 

 
 

• If Include Details is checked, then every transfer matching the filter criteria will be 
displayed in the report.  If it is unchecked, only the totals will be displayed. 
 

• Press the [Generate...] button to display the report in a separate browser tab.  Below is a 
sample report. 
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• Press the [Close] button to cancel the operation and return to the previous display. 
 

• Press [Help] to obtain an HTML display of this documentation.  The information will be 
displayed in a separate browser tab. 

 
 
3. Press [Help] to obtain an HTML display of this documentation.  The information will be 

displayed in a separate browser tab. 
 

	
  

	
  

	
  

	
  

 

	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  	
  


